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W For MacPlus (or 128K ROM) owners!

The Problem:

The Solution:

If you are using a Macintosh Plus, Enhanced 512K
Macintosh, or a Mac that has been upgraded with the new
128K ROMs (and 800K internal disk drive), you should
be reading this page.

The part of the Mac's brain that remembers (ROM) how
to locate fonts—The Font Manager— has been
rewritten. The Font Manager now expects to find some
extra information about font families that may not be
installed with your current fonts. (For the techies among
us: Font Manager expects not only FONT resources, but
accompanying FOND resources as well).

If you install new fonts into your System file, and the old
fonts do not have this additional (FOND) information,
there is a good chance that the Font Manager will not be
able to locate some of your fonts. At best, you might not
have access to all the installed fonts. At worse, this could

potentially crash programs.

Starting with the 3.1 version, the Font/DA Mover
(included on Disk 'A’ of this collection) will install this
extra (FOND) information for you, whenever you Copy
a font from one file to another, including the System file.

Here's what to do (before installing any new fonts!).
Use Font/DA Mover to Copy all the fonts that are
currently installed in your System file to a new
temporary file. Then select all the fonts in the temporary
file and Copy them back into your System file. This will
add all the new (FOND) information about the existing
fonts to your System file.

Once this has been done to a System file, you should
never have to repeat this proceedure for that particular

System. You should update all your System files.
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What should |

do first? all your World Class Fonts disks. They are not

And next?

copy-protected. Instructions for using the Finder to

copy disks and files can be found in your Macintosh
owner's manual.

Begin installing fonts using Apple's version 3.1 of the
Font/DA Mover (instructions begin on page 17). It
would also be helpful to read this manual first.
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The first thing you should do is make a backup copy of



What is not
included on
the disks

What is included
on the disks

BigCaps

DefaultFont

The Font Charter

TicTacToe

Directory Legend

The World Class Fonts disks are data disks. That is,
there is no System or Finder on any of them—in order to
leave more room for fonts and utilities. That means you
will have to start up the Macintosh with one of your own
System disks before you can do anything with World
Class Fonts.

World Class Fonts is primarily a collection of fonts
stored in files created by Apple's Font/DA Mover
application, included on disk 'A’ of each collection (see
Font/DA Mover instructions on page 17). There are also
some new utilities from Dubl-Click:

BigCaps is a fancy replacement for the Keycaps desk
accessory that came with your Macintosh (see
instructions on page 24 ).

DefaultFont is a desk accessory that lets you change
what's called the default application font. That's the font
many applications select for you to use when the
application is first opened (see instructions on page 28).

The Font Charter is an application that prints font charts
on the screen, ImageWriter or LaserWriter. The fonts
do not have to be installed in the System file (see
instructions on page 20).

TicTacToe is a desk acessory just for fun. We thought
you might be tired of the Puzzle that comes with the Mac
(see instructions on page 30).

What follows are two directories of your three-disk
collection (for volumes one and two). The Directory

of Disk Contents lists the contents of all files on all
disks. The Directory of Fonts lists the fonts
alphabetically; then the filename and disk number where
the font is located.

In both directories, fontnames marked with an asterisk
(*) are fonts that are actually larger or smaller than the
size listed, so they'll show up on MacWrite's Font menu.
The real size is at right in parenthesis. Sizes shown as
underlined or in bold were previously released on either
Mac the Knife volume one or two.
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g] Directory of Disk Contents

The Utilities Folder
BigCaps (desk accessory)

Default Font (desk accessory)
Font/DA Mover (application)
The Font Charter (application)

TicTacToe (desk accessory)

The Australian (folder)
Melbourne 9,12,18,24
Sydney 12,18,24,36

The Casual

Malibu 12,14,18,24,28,36
Monterey 24

Tokyo* 12,24 (14,28)

The Carmel
Carmel 24,48

The Gigantic
Stanford* 12,24 (36,72)

The Unusual

Boca Raton* 24 (30)
Dakar* 24 (30)
Frankfurt 18,24 36
New Orleans* 24 (36)
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1B Volume 1. Disk B

The Borderline

Borders1* 24 (36)
Borders2* 24 (36)
Borders3* 24 (36)

The Decorative
Berkeley 12,24
Greenbay 18,36
Hollywood 12,18,24
Liverpool 18,36

The Modern Age
Cape Canaveral 12,24
Detroit* 24 (36)

Las Vegas 12,24
Prague 18,36

Muleshoe
Muleshoe 12,18,24,36

The Wild West
Dallas 12,18,24
Laredo 12,24
Nuevo Laredo 9,18

Ye Old Types

Camelot 18,36

London 36

Luxembourg 14,18,24,36,48
Manchester* 24 (36)



tﬂ Directory of Disk Contents

The French (folder)

French Canadian (file)
Montreal 9,12,18,24

The Parisian (file)

Paris 2,12,18,24
Paris Caps 12,24

Parisian Heads (file)
Paris Headlines 24,36,48,72

The Silicon Valley (folder)

Cupertino (file)
Cupertino 9,12,18,24,36

Sunnyvale (file)

Sunnyvale 9,12,18,24,36
Sunnyvale Caps 12,24

Sunnyvale Heads (file)
Sunnyvale Headlines 24,36,48,72

Underwood (file)
Underwood 12
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2A Volume 2, Disk A

The Utilities Folder
BigCaps (desk accessory)
Default Font (desk accessory)
Font/DA Mover (application)

The Font Charter (application)
TicTacToe (desk accessory)

Frank Lloyd Write
Scottsdale 12,24
Tempe 12,24

The International

Instanbul 12,18,24

Kawasaki* 12,24 (14,28)

Tel Aviv 12,24 (IBM selectric layout)

The Monofonts
Boston 10,12,20,24

Washington DC 9,12,18.24

The Ruscii (AATSEEL layout)
Gorky 9,12,18,24

Minsk 12,24

Novgorod 9,12,18,24
Stalingrad 12,24

The Symbolic
Nazareth* 24 (36)
Odessa 24

Postal City ‘A" 18,36
Postal City B’ 18

The Teeny Tiny
Austin* 9 (6)
Babylon* 9 (4)

Reno* 5,9,10,18 (5,10)

U.S. Ruscii (phonetic layout)
Moscow 12,24
Norilsk 12,24



E] Directory of Disk Contents

Arlington
Arlington 9,10,12,14,18,20,24 36

The Classic Roman
Rome 18,36

The Elegant
Florence 12,24

The Greek To Me
Athena 12,24
Sparta 12,24

The Originals (folder)

The Original (file)
Chicago 9,10,24
Manhattan 12,24
Venice* 12,24 (14,28)

New York Heads (file)
New York Headlines 24,36,48,72

The Racey

Stuttgart 9,12,18.24
Stuttgart Caps 12,24

The Stenciled

Saigon 12,18.24
San Diego 24,48

The Valued
Ascii City 12
Hex City 12
Underwood 12

2C Volume 2, Disk C

The Cursive (folder)
Albuquerque 9,10,12,18,20,24
Sante Fe 9,10,12,18,20,24

The Boisean

Boise 18,36
Caldwell 9,12,18,24
Pocatello 12,24
Twin Falls 36

The Groovy
Woodstock 12,24

The Oriental

Canton 12,24

Hong Kong 9,12,18,24
Osaka 12,24

The Scandanavian
Copenhiigen 9,12,18,24
Helsinki 9,12,18,24
Stockholm 12,24

The Spotty
Hartford 48
Obispo* 24 (36)
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Directory of Fonts

(y%ﬂb.u_cg,uﬂ_ngf.mﬁ

ALBUQUERQUE -9,10,12,18,20,24 PT
ALBUQUERQUE 2C

ROISE

BOISE-18,36 PT
THE BOISEAN 2C

ARLINGTON [B

ARLINGTON -9,10,12,14,18,20,24 36 PT
ARLINGTON 2B

B8 & s s om G s & &

ASCHI CITY -12PT
THE VALUED 28

BORDERS1 & BORDERS2 & BORDERS3 - 24 PT
THE BORDERLINE1B

© cALDWELL [

CALDWELL -9,12,18,24
THE BOISEAN 2C

9|5 Aol BE

ATHENA (GREEK) - 12,24 PT
THE GREEK TO ME 2B

[&]Bostong

BOSTON (A MONOFONT) - 10,12,20,24 PT
THE MONOFONTS 2A

AUSTIH AUSTIN AUSTIN AUSTIN AUSTIN AUSTIN
ALISTIM HUETEH

AuSTIN LIE IH ™
AUSTIM I I I AUSTIM
AUSTIM ALETIM
AUSTIH AUSTIH AUSTIH AUSTIN AUSTIH AUSTIN

AUSTIN - 9PT
THE TEENY TINY 2A

b CAMCLOT

CAMELOT -18,26 PT
YEOLDE TYPES 1B

FAFYLOA BFARYLEN

CrraP TS

BABYLON-8 FT
THE TEENY TINY 2A

& Can{on &

CANTON - 1224 PT
THE ORIENTAL 2C

A Berkeley

BERKELEY - 1224 PT
THE DECORATIVE 1B

Mape] ==
i%l:al[;?l]aueral

CAPE CANAVERAL -12, 24 PT
THE MODERN AGE 1B

# Boca Raton

BOCA RATON - 24 PT
THE UNUSUAL 1A

+ CARMEB +

CARMEL - 24 48 PT
THE CARMEL 1A




Directory of Fonts

Chicago@

CHICAGO -98,10,24 PT
THE ORIGINALS 28

(Bl OPBbKMIAQ

GORKY (RUSSIAN) -9,12,1824 PT
THE RUSCII 24

@ COPENHAGEN

COPENHAGEN -9,12,18,24 PT

(2 GREENBRYZ

GREENBAY - 18,36 PT

THE SCANDANAVIAN 2C THE DECORATIVE 1B
Cupertino‘= e oA
v LB L = L
w L L. L 4
CUPERTINO - 9,12,18,24,36 PT ® STvve e You
CUPERTINO 1C b &
L3 w
g" "" ="‘ "'=
L ] L J = L] L}
L vy W L L L)
HARTFORD - 48 PT
DAKAR-24 PT THE SPOTTY 2C
THE UNUSUAL 1A

DALLAS £

DALLAS -121824 PT
THE WILD WEST 1B

b He ik g

HELSINKI - 9,12,18,24 PT
THE SCANDANAVIAN 2C

HEROI)

DETROIT - 24 PT
THE MODERN AGE 1B

88 a5 6484

HEX CITY - 12 PT
THE VALUED 2B

i Ploreence S a,

FLORENCE - 12,24 PT
THE ELEGANT 2A

% HOLLYWOOD

HOLLYWOOD - 12,18,24 PT
THE DECORATIVE 1B

FRANK<S==-FURT

FRANKFURT - 18,24 36 PT
THE UNUSUAL 1A

Hong Kong

HONG KONG - 8,12,1824 PT
THE ORIENTAL 2C




Directory of Fonts

[stanbul &

INSTANBUL - 12,1824 PT
THE INTERNATIONAL 2A

Htonphesber

MANCHESTER - 24 PT
THE YE OLDE TYPES 1B

YA D KA oY

KAWASAKI (JAPANESE) - 12 24PT
THE INTERNATIONAL 2A

¢ & o) (ol k'R /7
Manhattan

MANHATTAN - 12.24 PT
THE ORIGINALS 2B

§ Laredo %

LAREDO - 1224 PT & NUEVO LAREDO - 9,18 PT
THE WILD WEST1B

# MelBOURNE A

MELBOURNE -9,12,1B24 PT
THE AUSTRALIAN-MELBOURNE 1A

i A ™ N TP e A -
i AT v i AR

afh . { L L""-I L Y t‘-'li o B EHI
Buiwis % i - e A

| o —

LAS VEGAS -12,24 PT
THE MODERN AGE 1B

(M HC KA

MINSK (RUSSIAN) - 12,24 PT
THE RUSCII 2A

I Liverpool ==

LIVERPOOL - 18,36 PT
THE DECORATIVE 1B

Monterey A

MONTEREY - 24 PT
THE CASUAL 1A

Jhondon &

LONDON - 36 PT
YEOLDETYPES1B

I¥IMontreai

MONTREAL -9.12.18.24 PT
THE FRENCH CANADIAN 1C

lutembourg

LUXEMBOURG - 14,18,24 36 48 PT
YE OLDE TYPES1B

SN OCKBAX

MOSCOW (RUSSIAN) - 1224 PT
LS. RUSCII 2A

Malibu~

MALIBU - 12,14,18,24,.28 36 PT
THE CASUAL 1A

MULESHDE

MULESHOE -12,18.24,36 PT
MULESHOE 1B




A Directory of Fonts

#4 =l owy VU § (18
%Wm%m%

NAZARETH (SYMBOLS) - 24 PT NEW ORLEANS - 24 PT

THE SYMBOLIC 2A THE UNUSUAL 1A
E=EHOPMITBCK X t%’Els:em:au

NORILSK (RUSSIAN) - 1224 PT OSAKA -12,24 PT

U.5. RUSCIH 2A THE ORIENTAL 2C

BRI HOBIOPOIN 0B P4RIS A
NOVGOROD (RUSSIAN) -9,12,18.24 PT

THE RUSCII 2A PARIS - !'.‘l-‘!.:lzf.;s li:-?g P'l'll'w HEADS
THE PARISIAN (HEADS) 1C

lNY poeré'i:uu

Headlines oo e

NEW YORK HEADLINES - 24,36 48,72 PT
THE ORIGINAL  NY HEADS 28 Gia o ¢la G Gl

PeQeSeTe AL
Cbispo @ CITY A
OBISPO - 24'PT POSTAL CITY ‘A’ (SYMBOLS) - 18,36 PT
THE ORIENTAL 2C THE SYMBOLIC 2A

ODESSA (CHESS FONT) - 24 PT
THE SYMBOLIC 2A

POSTAL CITY "B’ (SYMBOLS)- 18 PT
THE SYMBOLIC 2A




Directory of Fonts

©PRAGUE

PRAGUE - 18,36 PT
THE MOCDERN AGE 1B

= S\

CranvHrpaao,
STALINGRAD (RUSSIAN) - 12,24 PT
THE RUSCI 2A

RENO REND RENMD REMO RENO

RENe E'El'l':' e
RENO-5.9,10,18 PT
THE TEENY TINY 2A
ER-O-MEx stock[F]holm
ROME - 18,36 PT STOCKHOLM - 12,24 PT
THE CLASSIC ROMAN 28 THE SCANDANAVIAN 2C
¥ Sai(l()n @ ‘%mtﬁ
. STUTTGART
SAIGON - 12,18,24 PT ' _
THE STENCILED 2B STUTTGART r:iéﬁ“f;;f:“ 12,24 PT

s SAN DIEGC

SAN DIEGO - 24,48 PT
THE STENCILED 2B

5 SUNNYVALE

SUNNYVALE -9,12,18,24 36 & CAPS-12.24
HEADS - 24,36,48,72 PT
SUNNYVALE 1C

Samta T &

SANTE FE - 9,10,12,18,20,24 PT
THE CURSIVE:SANTA FE 2C

Sydney

SYDNMEY - 12,18,24 ,36PT
THE ALISTRALIANSYDNEY 1A

SCOTTS

L)ALl =

SCOTTSDALE (FOR DRAFTING) - 1224 PT
FRANK LLOYD WRITE 2A

2 aAR-20

TEL AVIV (HEBREW) - 12,24 PT
THE INTERNATIONAL 2A

SISl 2 TTX R TT EIE

SPARTA (GREEK) - 12,24 PT
THE GREEK TO ME 2B

¢'n Enm ****

TEMPE (ARCHITECTURAL) - 12,24 PT
FRANK LLOYD WRITE 2A




Directory of Fonts

THE CASUAL 1A

UE‘/YLi,C Fooo

VENICE - 12,24 PT
THE ORIGINALS 28

TWIN FALLS -36 PT
THE BOISEAN 2C

FRllkS
e

Washington
D.C . =SS pEs

WASHINGTON DC (MONOFONT) -9,12,18,24 PT
THE MONOFONTS 2A

(vl M) [e] [€] [R] (W] # @ [O]

S0U SOM $0D SOC SOR 30W 300 500 30D

UNDERWOOD - 12 PT
UNDERWOOD 1C & THE VALUED 28

WRRDSTALKEE

WOODSTOCK - 12,24 PT
THE GROOVY 2C

1A VOLUME ONE, DISK A
1B VOLUME ONE, DISK B
1C VOLUME ONE, DISKC

LEGEND:

2A VOLUME TWO, DISK A
2B VOLUME TWO, DISK B
2C VOLUME TWO, DISK C

NOTE: POINT SIZES SHOWN IN BOLD INDICATE
FONTS THAT WERE PREVIOUSLY RELEASED

IN EMTHER MAC THE KNIFE™ VOLUME 1 OR 2,
OR BY APPLE COMPUTER, INC.




E] Setting Up Font Disks

Installing Fonts
and the System file

Text vs.
Display Fonts

When you install a font, you might wonder "where does
it go?" The answer is the System file—which can grow
very large, very quickly. That means you may have to be
careful about how much free disk space you leave
applications for "elbow room." (See the section on
Font/DA Mover for more on installing fonts—page 17).

MacPaint and Calculator Construction Set for instance,
both create temporary files while they are open. Also,
when something is cut to the Clipboard, it's actually
pasted into a Clipboard file, usually kept in the System
Folder. When printing, print image files are temporarily
written to the disk too. So, to be on the safe side, you
should allow from 25K to 75K of free disk space.

If you have an External disk drive, a good solution is to
create several Font System disks. That is, instead of
putting applications on the same disk as the System file,
try moving the application, the Clipboard file, and the
ImageWriter file to your data disk, and deleting them
from the System disk, leaving more space for fonts.

World Class Fonts can be classified into two basic types
of fonts: Display and Text. Generally, display fonts
look best as headlines for logos, signs, etc. Text fonts
look best as the "body copy” for letters, brochures, etc.
Text fonts are usually those in the 9 to 24 point range.
Display fonts are usually in the 18 to 72 point range.
This doesn’t mean that you can't use San Diego 24 to
write a letter, or Paris 12 to set a headline—it's just that
San Diego 24 is more appropnate for display purposes,
while Paris 12 is more suitable for text.

One subtle difference between a 24 point text font versus
a 24 point display font is the kerning. Kermning 1s a
typesetting term that refers to the amount of white space
between characters. Our display fonts will "kemn
tighter” than a text font of the same size. This is because
24 point text type is drawn with the same kemning as 12
point text type; insuring even spacing when printed
in"High" (or "Best") quality mode (see more below on
How Point Sizes Affect Print Quality).

Page 12



About Point Sizes

How Point Sizes
Affect Print Quality

Scrolling Font
Menus

To maximize precious disk space, you might want to set
up a Font System disk for MacWrite that contains
primarily text fonts, with a few headline faces sprinkled

in. Or a Font System disk for MacPaint that contains
mostly headline faces laced with text fonts.

9 Point
10 Point
v12 Poind
14 Point
18 Point
24 Point
36 Point
48 Point

The sizes shown in outline on a Size menu are the ones
that are installed in the System file for the currently
selected font. Fonts will always look better in the sizes
shown in outline (the real sizes). Sizes not shown in
outline will be scaled from the real sizes—often resulting
in jagged looking type.

When applications print using the "Standard” (or
"Faster") quality mode, the printer uses the same font
that's on the screen. But when the "High" (or "Best”)
mode is chosen, the printer uses a font twice the point
size as that on the screen. Because the printer can print
more dots per inch than can be drawn on-screen, it scales
a double-sized font down to occupy the same amount of
space the screen font's point size would occupy on paper.

Incidentally, MacPaint does not use any fonts during its
"Print Final”, so there's no need to install double-sized
fonts in the System file for printing.

With older versions of the System file, only 20 font
names would show on the Font menu. The ability to
scroll menus has been built into newer versions of the
System file. Your local Apple dealer can help you update
your System file. See the section on BigCaps for
examples of how to scroll font menus.
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Font Characters
Supported

Undefined
characters

International
Characters

Option-Key
Prefixed
International
Characters

In creating the Font Manager (in the Macintosh's ROM)
Apple has set up certain keystroke conventions.

We've tried to follow Apple's conventions closely.
However, we have deviated occasionally—often to make
use of undefined (non-reserved) characters, using them
for our own special symbols and characters,

To find out exactly how we have deviated in each font,
you may view the font in BigCaps or Font Charter. In
the case of foreign language fonts and symbol fonts, we
have deviated altogether (you may wish to see the font
charts for foreign and symbol fonts starting on page 31).

One of Apple's keystroke conventions is that any
keystroke that is not included in a font will be drawn as a

box. In Dubl-Click's fonts, an undefined character will
show up as a small Dubl-Click logo.

Most of our text fonts have international characters
(explained below) . But some do not. If you really need

the full set of international characters, you can use other
fonts instead or in addition to these:

No International Chars Use instead or in addition
Albuquerque Santa Fé (from Dubl-Click)
Kawasaki Tokyo (from Dubl-Click)
Manhattan New York (from Apple)
Paris Montreal (from Dubl-Click)

This keyboard chart shows the standard accent characters
that must be prefixed with an option + character
sequence. (Dashes indicate no international character
exists for this keystroke combination).

EEEF'” A|la | E | e ] Ojo|lU|u
Gtr)le | - |& | E| &6 | T |-]6]|-]|0
et I ATal-18121~181510H
Option] i -18|l-18]1%]|-]18]-10
Biwu | 4|8 |-|&|v|6|a]|ula
Petin] n | A | & | - |- | -|OB|&]| -] -
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Other International  This chart shows how to select standard International and

and Math Math symbols by using Option + character, or Shift +

Characters Option + character combinations. This information is
also available as displayed in the BigCaps desk accessory
(use the Underwood font to see which keystroke
produces each character). Not every one of these
combinations has been supported in all of our fonts.

Normal Option Shift+0Opt Normal Option Shift+0Opt
a a A n . 0
b I O (0] a a8
c ¢ ¢ p n m
d ? O q ® E
e 23 O r ® O
f f O s B O
g ® 0 t t O
h O O u H O
i i O v v &
J A O L z O
K O O H - O
g - O y ¥ O
m u O - Q O
| i | - - =
2 L] D - *= t
3 £ D I 1] ]
4 T 'D ] i [
5 0o O \ « »
6 § O - O
s q O : " fE
8 . " comma & O
9 a O period 2 O
0 0 O / + &
v . hidden icons

Special "hidden" We are proud to say that World Class Fonts are in

characters keeping with The Susan Kare Tradition of devoting the

Option+Shift+tilde combination as the "hidden
character” key. Many World Class Fonts also have other
hidden characters. The most common one is the
Option+Shift+colon which is the "flag" key. (Susan Kare
drew most of the fonts that came with the first
Macintoshes).
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Bolder Dash

Fractions

We have deviated from the standard Option+dash and
Shift+Option+dash combination. Our Option+dash
produces a longer than normal dash that typesetters call
an "em dash". Our Shift+Option+dash produces a bold
underscore character.

Every World Class Font that supports fractions will
follow the keyboard placement shown in this chart.

Option}{Shitland: | 1 2 3 4 S5 6 7T | 8 9

Produces:

Y| 2| Vo] W% | %A % v %s

Non Break Space

Very Large Fonts:

Very Small Fonts:

There are imes when you might not like the way your
word processor breaks lines for you. For instance, the
name Steve Jobs is a proper name and so the first and last
names should appear on the same line. To remedy this,
instead of typing a space between Steve and Jobs, type an
Option+space. In most World Class Fonts, the
Option+space is the same width as the normal space.

The exceptions to this rule are many of the symbolic,
picture and foreign language fonts, where often
Option+space is simply one-pixel wide. This is to allow
more exact positioning of graphic or special accent
characters in a line of type.

The Macintosh has a limit of 32K for any one font size.
This is important to you for two reasons. If you have a
128K Mac, you may not be able to use a large font due
to memory constraints. If you have a Mac with

S12K+ this means that some characters will be missing
from the larger fonts because they simply do not fit. For
instance, one of our 36 point headline fonts may contain
characters that it's 72 point big brother does not. So
printing a headline font in "High" or "Best" quality mode
may result in some unexpected undefined characters
being printed in your text.

Some Macintosh applications (spreadsheets in particular)
work quite well with our smaller-than-9-point fonts.
Applications will automatically adjust their line spacing
for the small fonts, which will yield a greater number of
lines (or cell rows) per page.
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AL Font/DA Mover application

Using Apple's The Font/DA Mover (Font and Desk Accessory Mover)
Font/DA Mover is an application for copying fonts and desk accessories
to install fonts and  among disks or removing them from disks. You will
desk accessories. need to use this application to install World Class Fonts,
and to install the BigCaps, DefaultFont and TicTacToe
desk accessories.
The Font and & menus in applications always contain the
fonts and desk accessories that are in the current startup
disk's System file (a file in the System Folder). Other
fonts and desk accessories are contained in files that look
like this (in the Finder):
(&7
A font file A desk accessory file
Be sure to use the It is important to use the 3.1 (or newer) version of the
3.1 or newer Font/DA Mover if you are using a Macintosh Plus, or
version. are using the 128K ROMs (see the front inside cover for
more information as to why).
@ Font
(O Desk Rccessory i
Athens 18 << Copy <« \] Malibu 12
Cairo 18 Malibu 14
Chicago 12 [ Remove | [Malibu 18
Courier 9 Malibu 24
Courier 10 Malibu 28 “
Courier 12 4568 bytes |nialibu 36
Courier 14 selected  Ipgnterey 24
System The Casual
on Hard Disk 20 [ Help | {on World Class Fon...
12726K free 39K free
@ TR I T Close | |
Malibu 14:  7he guick boown fox jumpe over &

Page 17




1. Select the
Font/DA Mover icon
and choose Open
from the File menu,

or just double-click
the icon.

2. Click either the
Font or the Desk
Accessory button,
depending on what
you want to add

or remove.

3. Use the Open
buttons to present
lists of any other
System, font or
desk accessory
files on any
inserted disk.

4. Open the file you
want to look at by
selecting its name
and then clicking
Open or by double-
clicking its name.

The Font/DA Mover is included on the "A" disk of this
collection. You can open it there or copy it to any other
disk. You can also open any font or desk accessory file
to open the Font/DA Mover automatically from the
Finder.

The list on the left includes all fonts or desk accessories
in the System file on the current startup disk, whether the
disk is in the internal or external disk drive. If you

open a font or desk accessory file instead of Font/DA
Mover, the list on the left shows the contents of that file.
Also, holding down the option key when the version

number appears in the upper left comer of menubar, is
the same as clicking the Desk Accessory radio button.

If necessary, first click Close to close the file currently
displayed. Each Open button lets you control what's
displayed in its list. Both the file you're looking at and
the disk it's on are shown below each list.

Whenever you click an Open button, a dialog box

appears with a directory of folders and System, font, or
desk accessory files on the current disk or in the current

folder. (Holding down the option key while clicking the
Open button will display all file types).

As always, use the Eject or Drive buttons to look at
files on different disks.

You can look at and work with any existing System, font,
or desk accessory files, like the ones that came with your
World Class Fonts disks. If you'd like, you can create a
new file for your own collection fonts or desk
accessories by clicking New, naming the file, and
clicking Create.
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5. Select the fonts
or desk accessories
you want to copy
or remove.

6. Click Copy to
copy the selected
fonts or accessories
in the direction the
arrows point, or
click Remove to
remove them.

7. Click Quit.

Caution: Memory
Constraints.

You can select from either list. Click to select a single
font or accessory, hold down the Shift key while you
click additional single fonts or accessories, or drag to
select a group. Shift-click to deselect a selected file. The
number of bytes selected is displayed as well as the
amount of space available on the disk. Both the name of
the current file and the name of the disk it's on are
displayed below each list.

When a single font is selected, the name, size and a
sample of the font are shown at the bottom of the
window; when more than one font is selected or when a
desk accessory is selected, nothing is displayed. (Holding
down the Option key and clicking on a desk accessory
displays some resource information).

Clicking Copy copies the fonts or desk accessories to the
file displayed in the opposite list; clicking Remove
removes them from the file they're in. If a font or
accessory with the same name as one you selected already
exists in the opposite list, it will be replaced by the
selected font or accessory. If you remove all fonts or
accessories from a font or accessory file, the file itself
will be gone the next time you click Open. (Have you
backed up your disks yet?). You can't remove certain
fonts the System needs.

Only fonts and desk accessories in the current startup
disk’s System file are available to applications you use
with that disk. You're limited to 15 desk accessories in a
single System file.

In the Finder, you can drag any font or accessory files
you no longer need to the Trash, or copy or move these
files between disks.

Some of our large display fonts may occupy too much
memory space to work properly on machines with less
than 512K of RAM. Click on a single font name in
Font/DA Mover to display it's size in K. A small font
would be in the 5K to 10K range. By contrast, our
largest display font is 32K.
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The Font Charter application

Using the The Font Charter is an application that prints two
Font Charter different kinds of font charts on either an Imagewriter
application. or LaserWriter printer.

The Font Charter application is located in the Utilities
Folder on World Class Fonts disk 'A'. To start the
application, double-click its icon (shown above). The
Font Charter will open you will see this on your screen:

% File Edit Font Size Style
| | The KeyCaps Font Chart

b "I'-U- e e e T H e e e R e B R O R R S HH S H R HH Y, -H-I'F

| Sample Text

al'." e e e e T B e e e e R N e H R B S e e e e e R S I o S e kY
li

2O TG G G e Grarrigr g gD g OO e O O,

E o
T HEHHEHEHEHEHTHEHEHEHEHEHEHE - CHEHE - EH B HOHEHEHIHEHE AT D D

The Keycaps Font Charter has two windows that correspond to the two
Font Chart window  kinds of charts that it prints. The Keycaps Font
Chart window (shown above) functions the way the
desk accessory functions. The big exception is
the location of the File, Font, Size and Elyle menus—

which, in Font Charter, are located on the menubar at the
top of the screen—instead of in the BigCaps window.

For more detailed information about operating The

Keycaps Font Chart window, please refer to the
section on using the BigCaps desk accessory .
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E[|=="SSSS===== The Ascii Font Chart

Lhicago

1234567890
s | a
ko a
. # &
& S &
# % &
i © A

KO R

R,

The Ascii Font
Chart window

abcdefghijkimnopqrstuvwuyz
ABCDEFGHIJKLMNOPORSTUVIDHY 2

A a a |!q f LR, h
b & b o G - ¢ ~
L & ¢ £ € & ¢ 4
D 4 d uﬁ N ln"'l § l"i’h
E w e E':. 1] A -
F b f o 0 a 9 &

The & Menu

12

The window shown above displays the first page of The
Ascii Font Chart, which is drawn using the current
font, size and style characteristics. The ascii values are
drawn to the left of the font's characters. Double-
clicking the titlebar of the window will “zoom" the
window to it's original size and position on the screen.

NREE O A e

As usual, this menu contains the names of desk
accessories which you can run with Font Charter. The
first menu item About Font Charter displays a dialog
displaying the program's version number. Clicking
anywhere in that dialog box, or pressing the return key
will make the dialog box go away.
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G i 8

Show Ascii Chart
Hide Keycaps Chart

Page Setup

frmam e S mr e S R

Print Ascii Chart

e

The File Menu

Open Font Mover File presents the standard "get a
file" dialog box with a list of Font/DA Mover font files,
You may select files on other disks as well as the current
startup disk. Any font that came from a file other than
the System file will be underlined when drawn on the
Font menu. Holding the option key down while
selecting Open Font Mover File will display a list of
all types of files.

Show/Hide Ascii Chart and Show/Hide Keycaps
Chart show or hide the Font Chart windows. Clicking
in the closebox of the window will also hide it.

Page Setup presents the standard dialog box for setting
printer pages. We recommend these settings for best
results: ImageWriters: "US Letter”,"Portrait”, "Better"
(or "Faster”). LaserWriters: "US Letter", "Portrait",
"93%", "Smoothing OFF", "Font Substitution OFF". Font
Charts will print much faster on an Image Writer than on
a LaserWriter, by the way.

Print Ascii Chart and Print Keycaps Chart will
present a dialog box asking which print quality you want,
(See appropriate settings above—some settings may
appear in this dialog instead of the Page Setup dialog).

The appropriate font chart window will be centered on
the screen. After the print image is built, a message
appears at the bottom of the screen, indicating that you
may cancel printing by holding down the command key
and typing a period. If you do not cancel, your chart will
start to print at this point.
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The Edit menu

Edit] S

Undo

Cut

Copy
Paste
Clear

®2

R

#H
*®C
®U

q

The Font, Size
and Style menus

Scrolling the
font menu.

Quit does just that—to the Finder or MiniFinder (if it is
installed).

This menu is useable only if a desk accessory is active or
if The Keycaps Font Chart window is in front of all
the other windows. When using the Edit menu with The
Keycaps Font Chart window, Undo does nothing.

The other menu items affect the sample text box.

These menus function in the same manner in Font
Charter as they do in the BigCaps desk accessory. The
only difference is that in Font Charter, they affect both
The Keycaps Font Chart window and The Ascii
Font Chart window. For more information on the use
of these menus, please see the section on BigCaps.

Unlike BigCaps, the ability to scroll Font Charter's Font
menu is not built in to the Font Charter program. It is,
however, built into System files that were released after
the Macintosh Plus was introduced. If you want the Font
Charter's Font menu to scroll, you need to update your
System file to the latest version. Your local Apple dealer
can help you do this.

Note: this will only affect you if more than 20 font
families are installed in your System file.
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@ BigCaps desk accessory

Using the BigCaps  BigCaps is a replacement for Apple's Keycaps desk
desk accessory accessory which came with your Macintosh. There are
two main differences between the desk accessories:
(1) BigCaps displays a wider variety of font styles and
sizes, and (2) BigCaps displays not only the fonts
contained in the System file, but those contained in any
Font/DA Mover font file.

The BigCaps desk accessory is contained in a Font/DA
Mover file of the same name, in the Utilities Folder on
World Class Fonts disk "A”. BigCaps must first be
installed using Apple's Font/DA Mover before it can be
used (see the Using Font/DA Mover section). After
installation, BigCaps will appear in an application's

¥ (Apple) menu.

After selecting BigCaps on the % menu, the following
window will appear:

Keyboard input Press the Option, Shift, or Caps Lock keys or press the
Option and Shift keys together on the Macintosh
keyboard; BigCaps displays the characters you can type
while holding down that key or combination of keys.

Using the mouse (instead of the keyboard key) to click on
the picture of the Option, Shift, or Caps Lock keys will
"lock” that case. Clicking again "unlocks" the case.
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You can either type the character you want from the
keyboard, or click in the BigCaps window. The sample
text box will display your input.

BigCaps Menus BigCaps has five menus. The standard Edit menu
appears in the menubar at the top of the Macintosh
screen, as it usually does. The other four menus (File,
Font, Size and Style) have been built into the top of the

window itself. In the illustration below, the
File menu has been pulled down from the BigCaps

menubar.
=l IS===——===== Dubl-Click’s Big Caps E
| ruh-i Font Size Stula gamnrte« Jext I
| Default Font Menul | |u
| Open FontFile  foy

| —— S|16|7|8|92|10|-]-~= |
Hhuutl gCaps_ ¢ [y “'lﬂ' ol }|\|
ole|tlegln]s|k
glzle|v|[b6|n(m|,

OO THHD DR OO - OO OO HODHORO - H OO - OO0 O

BigCaps with the e men: pulied dowe.

The File Menu The Default Font Menu item changes the Font menu

to display only the fonts that are contained in the System
file on the startup disk.

Open Font File presents the standard "get a file” dialog
box with a list of Font/DA Mover font files. You may
select files on other disks as well as the current startup
disk. Any font that came from a file other than the
System file will be underlined on the Font menu.

Holding the option key down while selecting Open Font
File will display a list of all file types. The files shown
may or may not contain displayable fonts.

About BigCaps displays the version number of this

desk accessory. Clicking the Dubl-Click logo in the
bottom left of the window does the same thing.
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The Font Menu

Scrolling the
Font Menu

All the fonts in the System file on the startup disk are
displayed in the Font menu. Any font that is in another
open file (see Open Font File above) will be

underlined on the font menu. A check mark appears next
to the currently selected font.

Up to nine fontnames will be displayed on the BigCaps
font menu at any one time. The font menu will scroll up
or down to reveal the rest of the fontnames. In the
illustrations below, the fontnames drawn in gray
represent what you cannot see on the menu.

Dragging the mouse in the menu’s title will scroll the
fontnames up towards the first name in the list (see
illustration, below left).

Dragging the mouse below the menu will scroll the
fontnames down towards the last name in the list (see
illustration, below right).

fithans
Athens Lang Lanapgial
Cape Conaveral | prergd”
Font
vChicago e
Geneva Greenbay
Greenbay tﬁﬁ-&'ﬁllﬁ
Lnnduﬁuﬂ Melbourne
Paris
Melbourne
Paris EtL:?tguﬂurt
Frague
Stuttgart Uenice
Benice 3
Scrolling to the top Scrolling 1o the bottom
of the list of the list.
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The Size Menu

| Size | S

9 Point
10 Point
vi2 Poimd
14 Point
18 Point
24 Point
36 Point
48 Point

The Style Menu

| Style| S

vPlain text

Italic
Underline
Diujtillinte]
Shadoll
conDensed

The Edit Menu

o] S

#2

Cut

Copy
Paste

Clear

b H
86C
LAl

Sizes that appear in @UfiR® indicate that a real font

size exists for the currently selected font. Selecting a size
not shown in outlined text will scale a real point size (not

always a pretty sight). A check mark appears next to the
currently selected font size.

When a font is first selected from the Font menu,
BigCaps tries to display it in the current font size. If the
new font doesn't have that size, BigCaps starts searching
with 9 point, until it finds the first real size for the font—
which will then be set as the currently selected font.

Styles can be combined for a variety of effects. The

styles you choose are checked in the menu. Choosing a
checked style will uncheck it. Choosing Plain text will
turn off all other styles.

Try experimenting with different styles for nifty results.
Many of our fonts were designed to look great in
different styles. For example: Las Vegas, Detroit,
Prague, Stanford, and Twin Falls, etc.

mm @Wﬂ?’[&ﬂ
NORMEL

POLD DUT. GHAD,

Experimenting with different styles of the Twin Falls Fons.

The Edit menu appears in the application’s menubar at
the top of the Macintosh screen. Cut, Copy, Paste and
Clear operate on the "Sample Text" box in the Bi
window. Undo has no effect. The Edit menu may have
more items than shown here, depending upon the
apphcanm that BigCaps is running on top of. Any
additional items have no meaning to
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@ DefaultFont desk accessory

Using the
DefaultFont
desk accessory

Starting
DefaultFont

The DefaultFont
menu items.

The DefaultFont desk accessory is contained in a
Font/DA Mover file of the same name, located in the
Utilities Folder on World Class Fonts disk "A".
DefaultFont must first be installed using Apple's
Font/DA Mover before it can be used (see the section on

Using the Font/DA Mover). After installation, the item
DefaultFont will appear on the % (Apple) menu.

Quit
AbloutDEfiaullithonit

Chicago
vbeneva
Monaco

When you first pull down the DefaultFont DA, the menu
shown above is added to the menubar, and the dialog
shown below appears for dramatic effect, letting you
know DefaultFont is installed. Clicking anywhere in the
dialog or pressing the return key will make it go away.

Default Font Setter 1.0 by Cliff Joyce.
Sets the font that many applications |
default to when they are first opened.

i ©1986 Dubl-Click Software, Inc.

The Quit menu item will remove the DefaultFont
menu from the menubar.

About DefaultFont displays the dialog box shown
above.

Page 28



The fontname
menu items.

The rest of the items are in the DefaultFont menu are
fontmames. Selecting a font immediately sets it as the
default font and displays the dialog box shown below to
confirm your choice. The only time this does not happen
1s when you select the font that already is the default font.
A check mark appears next to the default font's name in
the menu.

Current Default Font:

Geneva

What is a default
font and why
change it?

When an application, like MacWrite for instance, is first
opened you may notice that the Font menu has a check
mark next to Geneva. This is because Geneva is the

default font. The DefaultFont desk accessory allows you
to change this initial font setting to whatever you wish.

Other programs like Multiplan do not allow users to
change fonts at all. Multiplan always uses a font called
Seattle—unless it has been removed from the System file,
in which case Multiplan will try to use the default font. If
you'd like to have a little fun, try setting the default font
to something like the Reno or Austin font.

Since most applications look for the default font when
they are first opened, for predictable results you should
use the DefaultFont DA before running the application.
Note also that changing the default font will affect every
disk you use, and its setting will not be affected by
turning the Mac's power off, then on again.

Changing the default font also affects the font that the

Finder uses to print filenames. For best results, select a
default font that contains both 9 and 12 point sizes.
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@ TicTacToe desk accessory

Using the
TicTacToe
desk accessory

[] TicTacToe

The Controls

The TicTacToe desk accessory is contained in a
Font/DA Mover file of the same name, located in the
Utilities Folder on World Class Fonts disk "A".
TicTacToe must first be installed using Applc s Font/DA
Mover before it can be used (see the section on Using the
Font/DA Mover). After installation, the item
TicTacToe will appear on the & (Apple) menu.

When you first pull-down TicTacToe from the # menu,
its window looks like the picture at left. You are ready to
play, with the Mac playing first (the X), and you playing
the O mark.

Click the Dubl-Click logo button, and the TicTacToe
window enlarges to reveal these controls:

licTacToe

(Mac Plays First

( User Plays First

{ [ Resume Game |

M TicTacToe by CHIT Joyce
{ ©1985 Dubl-Click Software

e

Mac Plays First

User Plays First

Resume Game

Collapses the window back to normal size, and starts a
new game with the Mac playing an X mark.

Collapses the window back to normal size, and starts a
new game. The Mac waits for you to play an O mark.

Collapses the window, and resumes the current game.
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The Font Charts

Foreign keyboard
layouts

The Cyrillic
keyboard layouts

Equivalent U.S.
font styles

A number of World Class Fonts do not follow standard
keyboard layouts. Please consult the charts on the
following pages in order to locate specific characters.
All charts assume a Macintosh 512 using both the U.S.
keyboard and System folder.

There are two files of Cyrillic fonts on disk 2ZA. The
file called The Ruscii uses a standard cyrillic keyboard
layout. This layout is the result of a report called
Standardization of Computer Keyboards for Cyrillic
researched by the American Association of Teachers of
Slavic and East European Languages (AATSEEL).

Because the Macintosh has an option and a shift+option
case, we have added some additional characters to the
AATSEEL layout to facilitate word processing in Russian,
Serbo-Croation, Serbian, Bulgarian and Old Russian.

The file called U.S, Ruscii uses our own “student”
keyboard layout. The intention was to map the keyboard

phonetically to english, leaving most punctuation marks
in the position they occupy on a U.S. keyboard.

Our Cyrillic and Greek fonts are designed to match
when mixed with English (see chart below). Note that
the Cyrillic fontnames begin with the same letter as their
English counterparts. (* denotes US Ruscii layout).

Foreign Font Maiching English Font
Athena New York (or Manhattan)
Sparta Geneva

Gorky Geneva

Minsk Montreal (or Paris)
Moscow* Montreal (or Paris)
Norilsk* New York (or Manhattan)
Novgorod New York (or Manhattan)
Stalingrad Stuttgart

Stephen McClure and Cliff Joyce wish to acknowledge those ai
Cornell University and AATSEEL for their help with regard to our
Cyrillic fonts.
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E L American Association of
h.h.T.s-E- - Teachers of Slavic and
East European Languages
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u Dubl-Click's own Russian
™™ usc I I student phonetic
keyboard layout
POONETIC DUSSION REYDOODBD LOYODT

Lowercase
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SPRRTR & RTHENA
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HEBRELU

Lowercase
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kawaaaki 12/24

ABCDEFGHIJKLMNOPQRSTUVMWXNY 2 AL
mwwamwwm ¥ 1234567390 | &1

Irgzﬂui'ﬂ5+..HMﬂWFD
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All keystrokes are Option case. Inverted character = not Option case.

12 AND 24 POINT

Is Actually New York with a Twist

1 0 $ 1 3 = 0 C C

EI0 @ Fotion] (B8] (Refire] (Enter) (ackepace) ) (k] (Goubie-Gi]
2 W't 8 A 8 F 7T B E ) PN
ERCIMAOD LI~ B b (R o Pres
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O0O0Ot]=28050 A08K KR

All keystrokes are Option case. Inverted character = not Option case.
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cAbuguengue amd Kamta Fo B[ 1G]

cAwveigaben im 9, 10, 12, 18, 20, amd 2§ Paimd (Bines.
shift/option | ~ 1.2 3 I 4 8 B 7809 180 - 9%
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Undexwood Ascii/Hex Cllg

Heqular Characters
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| (brackets = no std. char)
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Int'l Characters
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POSTAL CITY)
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Here's some ideas on how to use Postal City:
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TEM [D[E 24 POINT

shift+opt 1 5 B 3 B & BE 0 - =

MI[S 5 i*#n-vn';.“v“-s“ss

shift+opt 0 i A S D F b H ™M < > 7
* ¥ 3 & = - * e 1 . B

shift+opt N TN S RO S
¢ H o e @ © i e By

EEEEEEE  Brick Wall
— C—3 Frame Wall

Opt+Spacebar = | pivel | Eistastor Desr

Spacebar = 1 symbol 1 Interior Door

€  Duplex Outlet N Double Action Door

®, Range Outlet in Frame Partition

s Switch - g French Doors

< Ceiling Finture in Frame Partition

4 Ceiling Fisture mi Folding Door

©  Ceiling Finture B Pocket Door

® Floor Outlet e Window

9 Weather Proof Plug | &5 Casement Window Open Dut

® Ceiling Fan Dutlet =] Double Hung Window Open Out

©® prop Cord ezt Casement Window in Brick Wall

4 Telephone ==t Casement Window in Frame Wall

shift | CIOTEDRIDLS shift | MOTERIDLS

A|“7 | common Brick or Steel |N|&) | Wood Panel

B|7/ | Face Brick or Cast Iron |0 |[U/l | Loose Fill Ins. or Batts

c|?2 | FireBrick |P | £2 | Board and Quilt Insulation

II.'l % | Concrete Block1 0 H—L Solid and Cork Insulation

E | {# | concrete Block2 R |l |sheet Metal Flashing

F| &% | Cut Stone s | 88 | Aluminum1

6 | &% | Cast Stone T [ &% | Aluminum2

H | %% | Rubble U | Z% | Bronze or Brass

I |72 | Glass1 U | = |Structural Steell

J | Insulation or Glass2 W| = |Structural Steel2

K| i% | Plaster H | = | Structural Steel3

L | % | Solid Plaster v | B | ceramic Tile

M| = | Wood Siding 2 | @3 | clay Tile
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A| Notes and Tips

Albuquerque
and Santa Fé

Arlington
Borders 1,2,3

Nazareth Message
Scrolls in MacWrite

Tempe &
Scottsdale

Tokyo and
Kawasaki

That these two fonts have the same lowercase characters.
The capital letters drawn differently, however.

Another lower case "t" is available as option "t".

Our Border fonts are monospaced, so borders can be
created easily in MacWrite. Start your border with the
TopLeft Corner character. Repeat the TopCenter char,
and end the line with the TopRight Corner char. On the
second line type the LeftCenter char, several spaces,
the RightCenter char, and a Return. Repeat this second
line several times. On the last line type the
BottomLeft Corner char, several BottomCenter chars,
and the BottomRight Corner char. Print your
document in two passes. First print the border—then
compose the text that goes inside the border in another
document. Put border printed page back in the printer,
and overprint the text on this page. For one-pass
border printing you may want to use MacPaint,
MacDraw or PageMaker instead of MacWrite.

The two ends of the scroll (see top of Nazareth font
chart) are "Option {" and "Option }". Select a font for
your message and type the first character. Select
Nazareth and type "Option \" . Keep alternating the
Nazareth Option \" character with your message's
characters until the message is complete. Note that wide
letters or fonts don't work well in the scroll.

These fonts are designed to work together as
architectural fonts. Tempe provides the basic
"template” for drawing, such as standard architectural
symbols for windows, walls, doors, electrical and
building materials, etc. Scottsdale contains lettering and
the interior and exterior furninshings. Although these
fonts will work in MacWnite, you may find it easier to
work with them in MacPaint or MacDraw.

These two fonts are the same font, except that Tokyo
contains international characters in it's option case, and
Kawasaki contains Japanese characters instead.

Page 47



A | Additional Fonts Available

Other Volumes

Additional Foreign
Fonts Package

We take requests
(and submissions)

Dubl-Click offers two World Class Fonts volumes,
priced at $39 per 3-Disk Set. A number of other fonts
are also available from Dubl-Click, but were not
included in either volume due to space considerations (or
uncertainty about demand). Special-purpose font disks
may be ordered direct from Dubl-Click at a price of $16
each. Call or write us for a current listing, as we are
continually adding new fonts.

This Foreign Fonts disk may be of interest to you if you
are a student or scholar of any of the following
languages: Polish, Czech, Hungarian, Albanian,

Turkish, Ancient Greek (with all the accents and
breathing marks), Sanskrit, Indo-European, phonetic
alphabets for linguistics (IPA and SIL), Ancient Germanic
languages (Old English, Old High German, Gothic, etc.),
Singhalese, and more. The price for this disk is $16.

If you have an idea for a special font or have drawn a
font that might be of interest to other Mac users, we'd
like to hear from you. Just write to us and include a
description of the font you'd like us to create, or include
a sample printout of the font you've created.
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The Legal Stuff

License Agreement
from Dubl-Click Software, Inc.

The price of World Class Fonts licenses the
rmdg for use on one Macintosh. Site
icenses are available ($1 per font, or $39 per
volume). Call or write for details.

Programmers wishing to incorporate any
Waorld Class Font into their programs need to
purchase a one-time site license and include
the ght and license notice with each

copy of their program. Call or write for
details,

If you discover physical defects in the media
on which this software is distributed, or in the
manuals distributed with the software, Dubl-
Click will replace the media or manuals at no
charge to you, provided you return the item to
be replaced with prmf of purchase to Dubl-
Click Software, Inc

The Fine Print from our Legal Beagles

EVEN THOUGH THE SOFTWARE HAS BEEN TESTED,
AND THE DOCUMENTATION REVIEWED, DUBL-CLICK
MAKES NO WARRANTY OR REPRESENTATION,
EITHER EXPRESS OR IMPLIED, WITH RESPECT TO
THIS SOFTWARE, ITS QUALITY, PERFORMANCE,
MERCHANTARBILITY, OR FITNESS FOR A
PARTICULAR PURPOSE. AS A RESULT, THIS
SOFTWARE IS PROVIDED "AS 15" WITHOUT
WARRANTY OF ANY KIND. THE ENTIRE RISK AS TO
THE RESULTS AND PERFORMANCE OF THE
SOFTWARE IS ASSUMED BY YOU. SHOULD THE
SOFTWARE PROVE DEFFECTIVE, YOU ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING,
REPAIR, OR CORRECTION. YOU RELY ON THE
SOFTWARE AND RESULTS SOLEY AT YOUR OWN
RISK. DUBL-CLICK SOFTWARE SHALL NOT BE HELD
LIABLE FOR ANY DIRECT, INDIRECT,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES
ARISING OUT OF THE USE, THE RESULTS OF, OR
INARILITY TO USE THE PRODUCT EVEN IF DUBL-
CLICK SOFTWARE HAS BEEN ADVISED OF THE
POSSIRILITY OF SUCH DAMAGES OR CLAIM. ALL
IMPLIED WARRANTIES ON THE MEDIA AND
MANUAL, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED IN DURATION
TO NINETY (90) DAYS FROM THE DATE OF THE
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Font/DA Mover License

This language has been required by
Apple Computer, Inc.

Apple Computer, Inc. makes no warranties,
either express or implied, regarding the
umlnwd software package, its
merchantability or its fitness for any particular
purpose. The exclusion of implied warranties
1s not permitted by some states. The above
exclusion mu}r nul: apply to you. This
wm-an%u‘ you with specific legal

may b: nllu:rna;h!s that you may
ham: which vary from state to state.

mwmn
copyrighted program le Computer, Inc.
licensed to Dubl-Click Sog\’; istribute
for use in combination with the
Fonts Volumes. This Apple software shall
not be copied onto another diskette (except for
nn:hive urposes) or into unless as
installation of
andfud:skmm%cnﬂmnﬂm
Fonts and/or desk accessories have been
installed, the Apple software shall not be used
bylnyﬂﬂﬁpmgmn.
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